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Chapter 1
Computer Language

DO AND LEARN!

1.	Fill in the blanks.
	 Ans.	 (a)	 The language that a computer can understand is called a 

machine language.
		  (b)	 Computer languages can be divided into four categories.
		  (c)	 The symbol     0    stands for the absence of an electric pulse and 

    1    stands for the presence of an electric pulse in a binary 
code.

		  (d)	 Translating programming languages into binary is known as 
translator system.

	 	 (e)	 Artificial intelligence is an example of   4th    generation 
language.

2.	Write True (T) or False (F).

	 Ans.	 (a)	 Prolog is an example of a procedure-oriented language.	 F
		  (b)	 4GLs are designed to reduce the overall time, effort 

and cost of software development.	 T
		  (c)	 Interpreters convert code into machine code when the 

program is run.	 T
	 	 (d)	 High-level computer languages use formats that are 

machine-dependent.	 F
		  (e)	 Machine language is the lowest and most elementary 

level of programming language.	 T
3.	Tick () the correct option.
	 Ans.	 (a)	 High Level language is also known as ‘Symbolic Programming 

Language.’
	 (i)	 Low level language	 (ii)	 Middle level language
	 (iii)	 High Level language	 (iv)	 4GL language
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		  (b)	 Low level language was the first type of programming 
language to be developed.

	 (i)	 Middle level language	 (ii)	 4GL language
	 (iii)	 Low level language	 (iv)	 High level language
	 	 (c)	 C++ and C# are examples of Object-oriented languages.
	 (i)	 Logic-oriented languages
	 (ii)	 Object-oriented languages
	 (iii)	 Procedure-oriented languages
 	 (iv)	 None of these
	 	 (d)	 FORTRAN, ALGOL, C, BASIC, and ADA are all examples of 

Procedure-oriented languages.
	 (i)	 Object-oriented	 (ii)	 Logic-oriented
	 (iii)	 Low level	 (iv)	 Procedure-oriented
	 	 (e)	 Which of the following languages is machine-independent?
	 (i)	 Machine	 (ii)	 Assembly
	 (iii)	 Java	 (iv)	 None of these

4.	Answer the following questions.
	 (a)	 Differentiate between an interpreter and a compiler.
	 Ans.	� Compiler:  The whole source code or program is converted into 

object code in one go and errors are listed out together. Once the 
program is error free, the process of compilation (translation of 
high level program into object code) is repeated and the object 
code is generated as well as stored.

		  Interpreter:  It converts programs into machine language line by 
line. A line is translated, and if error free, it is executed; otherwise, 
the conversion stops and the interpreter waits for the error to be 
corrected.

	 (b)	Write briefly about the following:
	 (i)	 4GLs
	 (ii)	 Object-oriented languages
	 (iii)	 Low level languages



Living with Computers 6 TRM 13

	 Ans.	 (i)	 4GLs:  4GLs are mainly non-procedural languages which use 
English-like syntax to design the instructions. Their main use 
is in the areas of artificial intelligence and databases.

	 	 	 	Some examples of fourth generation languages are SQL and 
LISP.

		  (ii)	 Object-oriented languages:  These languages use the object 
oriented programming method as the design approach for 
solving a given problem. In this programming language, a 
problem is divided into a number of objects which can interact 
by passing messages to each other. C++ and C# are examples 
of object-oriented programming languages.

		 (iii)	 Low level languages:  Also known as binary language, a low 
level language consists of strings of 0’s and 1’s. It is directly 
understood by the machine (computer) and needs no translation 
at all. The 0’s and 1’s are actually codes which are converted 
into electrical signals. The ‘off’ state of electrical signal is 
identified by 0 and the ‘on’ state is identified by 1. 

	 (c)	Write two advantages and two disadvantages each of:
		  (i)	 Middle Level Languages
		  (ii)	 High Level Languages
	 Ans.	 (i)	 Advantages of Middle Level Languages:
			   1.	 Programs written in machine language are replaceable by 

mnemonics, which are easier to remember.
	 	 	 2.	 Faster execution and efficient programming.
			   Disadvantages of Middle Level Languages
			   1.	 Long programs written in such languages cannot be 

executed on small computers.
			   2.	 It takes a lot of time to code or write the program, as it is more 

complex in nature.
		  (ii)	 Advantages of High Level Languages:
			   1.	 They are user friendly.
			   2.	 They are similar to English and use the English vocabulary 

and well-known symbols.
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			   Disadvantages of High Level Languages:
			   1.	 A high level language has to be translated into machine 

language by a translator, which takes time.
			   2.	 The object code generated by a translator might be 

inefficient compared to an equivalent assembly language 
program.

	 (d)	 Machine language is difficult to use and understand. Justify the 
statement by giving reasons.

	 Ans.	 Since machine language uses a string of 0’s and 1’s only, it is 
difficult to develop and use this language.

	 (e)	Write briefly about procedure-oriented languages.
	 Ans.	 �Procedure-oriented Languages:  In this language, a program is 

written as a sequence of procedures. Each procedure contains a 
series of instructions for performing a specific task. In this type of 
programming, a code once written in the form of a procedure can 
be used any number of times in the program by only specifying the 
corresponding procedure name. Examples of procedure-oriented 
languages are FORTRAN, ALGOL, C, BASIC and ADA.

COMPUTER TIME

	 1.	 Open a blank Word 2013 document. Type the advantages and 
disadvantages of different types of languages discussed in this 
lesson.

	 Ans.	 Do it yourself.
	 2.	 In groups of five, explore Google to find out information on Artificial 

Intelligence (AI). Prepare a presentation using MS PowerPoint and 
present it in the class.

	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
 	Ans.	1.  Also known as binary language, a low language consists of strings 

of 0’s and 1’s. It is directly understood by the machine (computer) 
and needs no translation at all. The 0’s and 1’s are actually codes 
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which are converted into electrical signals. The ‘Off’ state of electrical 
signal is identified by 0 and ‘On’ state is identified by 1.

		  2.  High level languages are basically symbolic languages that use 
English words and/or mathematical symbols rather than mnemonic 
codes. Each instruction in the high level language is translated 
into many machine language instructions that the computer can 
understand. Examples: BASIC, C++.

		  3.  Fourth generation language or 4GLs are mainly non-procedural 
languages which use English-like syntax to design the instructions. 
Their main use is in the areas of Artificial Intelligence (AI) and 
databases. Some examples of fourth generation languages are: 
SQL, LISP, etc.

		  4.  Compiler: The whole source code or program is converted into 
object code in one go and the errors are listed out together. Once 
the program is error-free, the process of compilation (translating 
high level program into object code) is repeated and the object 
code is generated as well as stored. 

	 	 	 Interpreter:  It converts programs into machine language line by 
line. A line is translated, and if error free, it is executed; otherwise, 
conversion stops and the interpreter waits for the error to be 
corrected. Interpreted third generation languages are relatively 
slow because they are translated whenever there is a need of 
execution.

Answers of Worksheet

	 I.  	 1.  (a)  2.  (b)  3.  (c)  4.  (a)  5.  (b)
	 II.  	 1.  (b)  2.  (c)  3.  (d)  4.  (e)  5.  (a)
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Chapter 2
More About PowerPoint

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 In PowerPoint, to apply animation, select the Animations tab.
		  (b)	 The Entrance effect controls how an object enters a slide.
		  (c)	 A Motion path moves an object within the slide along a 

predetermined path.
		  (d)	 Applying an animation effect to the whole slide is called slide 

transition.
		  (e)	 The Playback tab has the options to control how an audio will 

play.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Animation gives colours to objects on slides in a 

presentation.	 F
		  (b)	 We can apply only one animation effect to an object present 

on a slide.	 F
		  (c)	 Entrance, Emphasis, Exit, and Motion Paths are different 

categories of animation effects.	 T
		  (d)	 The Emphasis effect controls how an object takes exit from a 

slide. 	 F
		  (e)	 We can record our own sound or audio and add it to our 

presentation.	 T
3.	Tick () the correct option.
	 Ans.	 (a)	 Which of the following can be inserted to a slide?
	 (i)	 Images	 (ii)	 Sound
	 (iii)	 Movies	 (iv)	 All of these
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		  (b)	 Animations make a slide show more Attractive.
	 (i)	 Heavy	 (ii)	 Clean
	 (iii)	 Attractive	 (iv)	 All of these
		  (c)	 Animations are of two types:
	 (i)	 Animation and Motion Paths
	 (ii)	 Slide timings and Transitions
	 (iii)	 Animation and Transition
	 (iv)	 Transition and Effects
		  (d)	 Which of the following is not an animation effect?
	 (i)	 Emphasis	 (ii)	 Entrance
	 (iii)	 Round	 (iv)	 Motion Paths
		  (e)	 Applying animation effects to the whole slide is called Slide 

transition.
	 (i)	 Slide animation	 (ii)	 Animation
	 (iii)	 Motion	 (iv)	 Slide transition

4.	Answer the following questions.

	 (a)	 What do you understand by the term ‘Animation’ with respect to a 
PowerPoint presentation? Explain briefly.

	 Ans.	� To give life to your presentation, PowerPoint provides various 
animation and transition tools. With the help of these tools, you 
can change the way objects appear, move and disappear on the 
slide.

	 (b)	 Name the different categories of animations that can be applied to 
different objects on a slide. Write the significance of each.

	 Ans.	 The different categories of animations are:
		  	 Entrance: This effect controls how the object enters the 

slide. For example, with the Bounce animation the object will 
appear on to the slide and then bounce several times.

		  	 Emphasis:  Emphasis animation effects determine how the 
slide object calls attention towards itself while it is on the slide. 
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These animations are often triggered by a mouse click. For 
example, you can set an object to spin when you click the 
mouse.

		  	 Exit: This effect controls how the object exits from the slide. For 
example, with the Fade animation the object will simply fade 
away.

		  	 Motion Paths: A motion path moves an object on the slide 
along a predetermined path like a circle or a line.

	 (c)	 Differentiate between animation and transition. Give one example 
of each.

	 Ans.	� Animation effects can be given to individual objects present on a 
slide. They can be of different types like Entrance, Emphasis, Exit 
and Motion Paths.

		  Transition is an animation technique in Flash in which the slide 
as a whole is animated. For example, how a slide enters, exits or 
appears while the slide show is going on.

	 (d)	 Write the steps to insert an audio to a slide in a PowerPoint 2013 
presentation.

	 Ans.	� To insert an audio to a slide in a PowerPoint presentation, follow 
these steps:

		  1.	 Select the slide on which you want to add the audio file.
		  2.	 Select the Insert tab and click the Audio drop-down arrow from 

the Media group and select Audio on My PC from the drop-
down menu that appears.

		  3.	 Locate and select the desired audio file, then click Insert.
		  4.	 The audio file will be added to the slide and will be selected by 

default. You can click the play/pause button to play the audio 
file.

	 (e)	 Meera has created a PowerPoint presentation from a topic in her 
Science book. She has added interesting animation effects to 
objects on the slides. To one of the objects in slide number 5, she 
has applied five different animation effects. While previewing the 
presentation, she realised that the order of the animations is not 
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correct. Help Meera change the order to the correct sequence. 
Write the steps in your notebook.

	 Ans.	 Meera can change the order of the slides by following these 
steps:

		  1.	 Select the number label of the effect needs to be changed.
		  2.	 From the Animations tab, click the Move Earlier or Move Later 

command to change the order.

COMPUTER TIME

Create a PowerPoint presentation on the topic ‘Trees are our best friends’. 
Use and apply all the PowerPoint tools that you have learnt till now. Search 
for some appropriate audio and video clips from the Internet at home with 
the help of your parents and bring them in a pen drive to school. With the 
permission of your teacher, add these in the presentation you are making.
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
 	 A.	 1.  Exit  2.  Animation  3.  Animation  4.  re-ordering  5.  Transition
 	 B.	 1.  It is a tool in PowerPoint with the help of which you can change the 

way objects appear, move and disappear on the slide.
		  2.	 Entrance: This effect controls how the object enters the slide. For 

example, with the Bounce animation the object will appear on to 
the slide and then bounce several times.

			   Emphasis: Emphasis animation effects determine how the slide 
object calls attention towards itself while it is on the slide. For 
example, you can set an object to spin when you click the mouse.

			   Exit: This effect controls how the object exits from the slide. For 
example, with the  Fade  animation the object will simply fade 
away.

		  3.	 If you select a new animation from the Animations group, it 
will  replace the object’s current animation. However, if you 
wish to apply more than one animation  on to an object, like 
an Entrance and an Exit effect, follow the given steps: 
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		  Step 1: Select the object.
		  Step 2: Click the Animations tab.
		  Step 3: In the Advanced Animation group, click the Add Animation  

            button to view the available animations.
		  Step 4: Select the desired multiple animation effects.

Answers of Worksheet

	 I.  	 1.  (c)  2.  (b)  3.  (a)  4.  (b)  5.  (d)
	 II.  	 1.  F  2.  F  3.  F  4.  T  5.  T
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Chapter 3
Windows 10

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 If you hover your mouse over an icon on the taskbar associated 

with a program that is running, you see thumbnails of all the 
copies of the program.

		  (b)	 Clicking the Start button on the desktop will launch the Start 
screen.

		  (c)	 Unpin the taskbar before changing its location.
		  (d)	 The date and time is displayed on the lower right corner of 

the taskbar on the taskbar in Windows 10.
		  (e)	 To change the font size of the icons, open Settings and select 

the System → Display option.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 You cannot remove unnecessary files with the built-in 

Disk cleanup utility of Windows 10.	 F
		  (b)	 When you have an app open, you can press the 

Windows key to switch to the Start screen.	 T
		  (c)	 You cannot open more than one application  

simultaneously in Windows 10.	 F
	 	 (d)	 You can remove temporary files from your computer by 

pressing the Delete key from the keyboard.	 T  
	 	 (e)	 To delete system files that are no longer needed on your 

computer, click Clean up system files.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 The taskbar was first introduced with Microsoft Windows   95 .
	 (i)	 98	 (ii)	 97
	 (iii)	 95	 (iv)	 XP
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	 	 (b)	 You can rearrange icons that appear in the notification area by 
dragging them to a different spots.

	 (i)	 dragging	 (ii)	 moving
	 (iii)	 clicking	 (iv)	 None of these
		  (c)	 You can hold down the Windows key and press the D key to 

switch to the Desktop view.
	 (i)	 Ctrl 	 (ii)	 Alt
	 (iii)	 Shift	 (iv)	 Windows
		  (d)	 Which of the following is not part of the Personalization menu?
	 (i)	 Background	 (ii)	 Date and Time
	 (iii)	 Themes	 (iv)	 Colors
		  (e)	 You can hold down the Alt key and then press the Tab key one 

or more times to switch between your open apps.
	 (i)	 Windows 	 (ii)	 Shift
	 (iii)	 Ctrl	 (iv)	 Alt

4.	Answer the following questions.
	 (a)	 What is the use of the taskbar in Windows 10?
	 Ans.	� Taskbar is an element of an operating system that allows you to 

locate and launch programs or view any currently opened program 
through the Start menu. It also allows the user to check the date and 
time and items running in the background through the Notification 
Area.

	 (b)	 Write in brief about each of the following:
	 	  (i)	 Notification Area
		  (ii)	 Search bar
	 Ans.	  (i)	 The Notification Area is located at the right side of the 

taskbar, and it contains app icons that provide the status and 
notifications about various things such as incoming e-mails, 
updates and network connectivity.

	 	 (ii)	 The Search bar allows you to search for apps, files, etc., 
present on your computer’s hard disk or from the web.
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	 (c)	 Why is it important to use the Disk Cleanup tool in Windows 10?
	 Ans.	 During the normal use of your computer, you will accumulate a 

number of unnecessary files. You can remove these files with the 
built-in Disk Cleanup utility of Windows 10.

	 (d)	 Name the two types of icons present on the taskbar of Windows 10.
	 Ans.	 The taskbar consists of two kinds of icons:

		   (i)	 Icons that have been pinned there: Windows OS comes 
with two icons on the taskbar, one for Microsoft Edge and one 
for File Explorer.

	 	 (ii)	 Icons associated with running desktop programs:  Every 
time a program starts, an icon for it appears on the taskbar. 
If you run three copies of the program, only one icon shows 
up. When the program stops, the icon disappears.

	 (e)	 Write the steps to unpin an icon from the taskbar.
	 Ans.	 To unpin an icon from the taskbar, follow these steps:
	 	 1.	 Right-click on the icon that you have to unpin from the taskbar.
		  2.	 Select the Unpin this program from the taskbar option from 

the list. The selected icon gets unpinned from the taskbar.
	 (f)	Write briefly about any three options available under the 

Personalization menu of Windows 10.
	 Ans.	� There are different options available under the Personalization 

menu. Three options are described below:
		  	 Background: From here, you can choose and customise the 

background of the desktop of your computer.
		  	 Colors: By default,  Windows 10 will assign an accent colour  

based on your desktop background image. However, you can 
turn this feature off if you want to choose your own accent 
colour, as explained above.

		  	 Lock Screen: From here, you can customise the appearance of 
your Lock screen.  As with your desktop background, you can 
use a built-in picture or select Browse to choose one of your 
own.
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	 (g)	 Ms Ruby has now shifted to USA but the time in her laptop is still 
set as per India. She doesn’t know how to change the date and 
time of her laptop. Help her by telling the steps to change the time 
according to USA. 

	 Ans.	 Ms Ruby will follow these steps:
		  1.	 She will click on the date/time display in the taskbar to view 

the date and time settings for her computer in a small pop-up 
window.

		  2.	 In this window, she can click the Change date and time settings 
hyperlink to open the Date and Time dialog box, where she can 
set the date and time.

		  3.	 To manually set the date and time, she can click the Change date 
and time button to open the Date and Time Settings dialog box.

	 	 4.	 Next, she will select the month and year from the Date calendar.
	 	 5.	 In the Time area, she will enter the current time into the text box.
	 	 6.	 When finished, she will click the OK button to apply the desired 

settings.

COMPUTER TIME

	 (a)	 Pin any two useful icons on the taskbar.
	 (b)	 Follow the steps as given in this lesson to perform disk cleanup of 

your computer system.
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities

Icons Taskbar Date and Time

Start Notification Area Show Desktop

Answers of Worksheet
	 I.  	 1.  (c)  2.  (b)  3.  (d)  4.  (b)  5.  (b)
	 II.  	 1.  T  2.  F  3.  T  4. F  5.  T
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TESTING TIME – 1
(BASED ON LESSONS 1 TO 3)

1.	Match the following:
	 Ans.	 (a)	 0’s and 1’s	 (i)	 Animation effect
	 	 (b)	 Mnemonics	 (ii)	 Taskbar
	 	 (c)	 Emphasis	 (iii)	 Machine language
	 	 (d)	 Pin a program	 (iv)	 Notification area
		  (e)	 Date and time	 (v)	 Assembly language

2.	Write the purpose of each of the following categories of animation 
effects in PowerPoint.

	 Ans.	 (a)	 Entrance: This effect controls how the object enters the 
slide. For example, with the Bounce animation the object 
will appear on to the slide and then bounce several times.

	 	 (b)	 Emphasis:  Emphasis animation effects determine how 
the slide object calls attention towards itself while it is 
on the slide. These animations are often triggered by a 
mouse click. For example, you can set an object to spin 
when you click the mouse.

	 	 (c)	 Exit: This effect controls how the object exits from the 
slide. For example, with the Fade animation the object 
will simply fade away.

	 	 (d)	 Motion Paths: A motion path moves an object on the slide 
along a predetermined path like a circle or a line.

	 3.	 Label the following figure of the taskbar of Windows 10.
	 Ans.	

Icons Taskbar Date and Time

Start Notification Area Show Desktop
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4.	Unscramble and write the correct term related to computer 
languages.

	 Ans.	 (a)	 S S A M E L B R E	 ASSEMBLER�
	 	 (b)	 T N I R E R E P E T R	 INTERPRETER
	 	 (c)	 E R P M L C O I	 COMPILER
	 	 (d)	 N E M M N I O C S	 MNEMONICS

5.	Answer the following questions.
	 (a)	 We need a translator for high level languages. Justify the statement 

giving reasons.
	 Ans.	� We need a translator because a computer understands only 

machine language. Therefore, the programs written in high level 
languages need to be converted into machine language for 
processing.

	 (b)	 What is meant by 0’s and 1’s in machine language?
	 Ans.	� The 0’s and 1’s are codes which are converted into electrical 

signals. The ‘off’ state electric signal is identified by 0 and the on 
state is identified by 1.

	 (c)	 Mention any two advantages of applying animation effects to a slide 
show.

	 Ans.	 Two advantages are:
		  1.	 They make the slide show interesting.
		  2.	 They add life to the slides.
	 (d)	 What do you understand by pinning a program? Write in short giving 

one example.
	 Ans.	� Bringing a program icon on the taskbar is called pinning. For 

example, if you work very often in MS Word, you can pin its icon 
on the taskbar so that you can open it quickly.

	 (e)	 Where is the Date and Time tool present on the desktop of Windows 
10? Mention any two tasks that can be performed with the help of 
this tool.

	 Ans.	 Date and Time tool is present in Notification Area of the taskbar on 
the extreme right. With this tool, we can:

		  1.	 Change the date
		  2.	 Change the time zone
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Chapter 4
Mail Merge with MS Word 2013

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Mail Merge is a useful tool which allows you to create multiple 

letters, labels, envelopes and name tags.
		  (b)	 While performing a mail merge, you need a Word document 

and a mailing list which is typically an Excel workbook.
		  (c)	 The mail merge process has three documents involved in 

creating and printing letters and e-mails.
		  (d)	 Main document contains the data which is used to fill in 

information in your main document.
		  (e)	 Merged document is a combination of the main document 

and the mailing list.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 The address on the envelope or the body of a letter 

or an e-mail message is different for each version 
of the merged document.	 F

		  (b)	 Mailing list contains the addresses to be printed on 
the labels or envelopes.	 T

		  (c)	 Information is gathered from the mailing list and 
inserted into the main document, resulting in the 
merged document.	 T

		  (d)	 Excel has a very useful feature called mail merge.	 F

		  (e)	 The mail merge process has three documents 
involved in creating and printing letters and e-mails.	 T

3.	Tick () the correct option:
	 Ans.	 (a)	 Start Mail Merge option is present in the Mailings tab.
	 (i)	 Review	 (ii)	 References
	 (iii)	 Mailings	 (iv)	 View
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		  (b)	 The last step in the mail merging process is Saving/Exporting
	 (i)	 Saving/Exporting
	 (ii)	 Creating a data source
	 (iii)	 Merging the data with the main document
	 (iv)	 Defining the merge fields
		  (c)	 Start from a template changes the view and gives you the 

option to choose your document.
	 (i)	 Use the current document 
	 (ii)	 Start from existing document
	 (iii)	 Start from a template
	 (iv)	 None of these
		  (d)	 The Step by Step Mail Merge Wizard option is available under 

which section of the Mailings tab?
	 (i)	 Envelopes	 (ii)	 Labels
	 (iii)	 Start Mail Merge	 (iv)	 Select Recipients
		  (e)	 Click Address block to add the recipients’ addresses at the 

top of the document.
	 (i)	 Address block	 (ii)	 Greeting line
	 (iii)	 Electronic postage	 (iv)	 More items

4.	Answer the following questions.
	 (a)	 What is Mail Merge?
	 Ans.	� Word has a very useful feature called Mail Merge. This feature 

allows you to create multiple letters, labels, envelopes, name tags 
and much more using information stored in the form of a list, a 
database, or a spreadsheet. 

	 (b)	 Write briefly about each of the following:
		    (i)	Main document
		   (ii)	Mailing list
		  (iii)	 Merged document
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	 Ans.	  (i)	 Main Document:  This document contains text and graphics 
that are identical for each version of the merged document. 
For example, the address on the envelope or the body of a 
letter or an e-mail message.

		   (ii)	Mailing List:  This document contains the data which is used 
to fill information in your main document. For example, your 
mailing, which list contains the addresses to be printed on the 
labels or envelopes.

		   (iii)	Merged Document:  This document is a combination of the 
main document and the mailing list. Information is gathered 
from the mailing list and inserted into the main document, 
resulting in a merged document (letters, e-mails, labels or 
envelopes) personalised for different people on the mailing 
list.

	 (c)	 What is the use of the Edit recipient list option of Mail Merge?
	 Ans.	� The Edit recipient list option lets you open the list, edit it or make 

changes and select and deselect recipients to whom the document 
is to be sent.

	 (d)	 What are the three main stages of Mail Merge?
	 Ans.	 Three main stages of Mail Merge are:
			    (i)	 Create the main document.
			    (ii)	 Create a data source.
			    (iii)	 Merge the main document with the data source.
	 (e)	 Mr Ashok wants to invite his friends for his retirement party. He 

does not know how to use Mail Merge to invite all his friends at 
once. Help him by suggesting the steps required to perform the 
Mail Merge process.

	 Ans.	 1.	 Open a blank Microsoft Word document and select the Mailings 
tab.

		  2.	 Click Start Mail Merge.  A drop-down list appears.
		  3.	 Choose Step-by-Step Mail Merge Wizard from the drop-down list.
		  4.	 Select your document type as Letters and Click Next: Starting 

document.
		  5.�	 Select the starting document from the options. Select Use the 

current document and then click Next: Select recipients.
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		  6.	 Now click Type a new list from the Select recipients options and 
click the Create link under Type a new list option to type the 
name and address of recipients.

		  7.	 On clicking, the New Address List dialog box will appear.
		  8.	 Type the recipient information in the table. To add more entries, 

click the New Entry button and after adding all the recipients, 
click OK.

		  9.	 On clicking the OK button, the Save Address List dialog box 
appears. Give a file name and click the save button.

		 10.	 On saving the list, the Mail Merge Recipients dialog box will 
appear. Here, you can add or remove your recipients from the 
merge. Once completed, click the OK button.

		 11.	 Click Next: Write your letter.
			   Now you’re ready to write your letter.  When it’s printed, each  

copy of the letter will be the same; only the recipient data (such 
as the name and address) will be different.

		 12.	 Place the insertion point in the document where you want the 
information to appear. Choose one of the four placeholder 
options: Address block, Greeting line, Electronic postage, or 
More items.

		 13.	 Click Address block to add the recipients’ addresses at the top 
of the document. 

		 14.	 In the Insert Address Block dialog box, check or uncheck boxes 
and select options on the left until the address appears in the 
way you want it to.

		 15.	 Preview the letters to make sure the information from the 
recipient list appears correctly in them. You can use the left 
and right scroll arrows to view each document.

		 16.	 Click Print to print your letters or Edit individual letters to further 
personalise the letters.

COMPUTER TIME!

You are celebrating your birthday by throwing a party for your friends and 
relatives. Write a letter in MS Word and use the Mail Merge tool to send 
the letter to 10 friends. 
	 Ans.	 Do it yourself.
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Answers of Suggested Class Activities
 	 A.	 (a)	 For sending a message to all students of a class.
		  (b)	� For printing labels for each student with the same message  

(to be pasted on their notebooks).
		  (c)	� For sending invitation letters of Annual Day celebrations to all 

the parents.
 	 B.	 1.  (a)  2.  (b)  3.  (a)  4.  (c)

Answers of Worksheet

	 I.  	 1.  Mail Merge  2.  Mailing List  3.  Select Recipients
		  4.  Letters  5.  Complete the Merge
	 II.  	 1.  F  2.  F  3.  T  4.  T  5.  F
	 III.  	 1.  It is a tool that helps in creating and sending multiple documents  

with minimum effort.
		  2.  Recipient list contains information like name, address, etc., of all 

the people who will be sent the mail.
		  3.  Letter is the document containing the message that has to be 

merged with the recipient list.
		  4.  Data source is a document that contains personalised information 

such as names, addresses and phone numbers.
		  5.  Creating a Main Document or/and the template
			   (a)	 Creating a data source
			   (b)	 Defining the merge fields in the main document
			   (c)	 Merging the data with the main document
			   (d)	� Saving/Exporting the main document and the merged  

document, if required
	 IV.  	 1.  A  2.  S  3.  S  4.  S  5.  A
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Chapter 5
More About MS Excel 2013-Editing

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 In order to format a group of cells in any form, we need to 

select them first.
		  (b)	 Number group is also known  as the Formatting group.
		  (c)	 Decrease Indent moves your content closer to the cell border.
		  (d)	 Alignment group buttons are useful in setting the location, 

direction and rotation of the text within a cell.
		  (e)	 Merge and Center is used to combine and centre the text of 

cells into a single large cell in Excel.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Use the Shift key along with the arrow keys to select 

the range of cells.	 T

		  (b)	 Wrap text is used to decrease font size in Excel.	 F
		  (c)	 Font Color is used to apply and change the font colour 

of text in Excel.	 T
		  (d)	 Percentage Format is used to calculate the percentage 

of the given number.	 F
		  (e)	 Formats such as General, Number, Currency and 

Accounting, etc., are part of the Number group.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 To select non-adjacent cells and cell ranges, hold the Ctrl key 

and click on the cells.
	 (i)	 Ctrl	 (ii)	 Shift
	 (iii)	 Alt	 (iv)	 Enter
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		  (b)	 Click on any cell in the row and then press Shift + Space to 
select that row.

	 (i)	 Ctrl + Space	 (ii)	 Alt + Space
	 (iii)	 Shift + Space	 (iv)	 Ctrl + Shift + Space
		  (c)	 The option to Insert or delete a row or column is present under 

the Cells group of the Home tab. 
	 (i)	 Editing	 (ii)	 Styles
	 (iii)	 Alignment 	 (iv)	 Cells
		  (d)	 The fourth group is the Number Group of the Home tab.
	 (i)	 first	 (ii)	 third
	 (iii)	 fourth	 (iv)	 fifth
		  (e)	 Orientation rotates the direction of text of a cell (i.e., vertically 

or horizontally) in Excel.
	 (i)	 Hyphenation	 (ii)	 Orientation
	 (iii)	 Wrap text	 (iv)	 None of these

4.	Answer the following questions.
	 (a)	 Name the three tabs of the Home group used for formatting cells.
	 Ans.	� Font, Alignment, Number.
	 (b)	 Write in brief about each of the following:
		   (i)	 Number group
		  (ii)	 Formatting cells
	 Ans.	  (i)	 Number group:  The Number group is located in the Home 

tab. We may call the Number group as the Formatting group 
as well.

				   Various options available under Number group are:
			   	 Number Format – Applies a number format to numbers.
			   	 Percentage Format – Applies a percentage format to 

number entered in the worksheet.
			   	 Accounting Number Format – Applies an accounting 

number format to numeric entries.
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			   	 Percent Style – Applies a percent format to numbers.
			   	 Comma Style – Applies a comma format to numbers.
			   	 Increase Decimal – Used to increase decimal places for 

numbers.
			   	 Decrease Decimal – Used to decrease decimal places for 

numbers.
		   (ii)	Formatting cells:  The entire content of a cell uses the same 

formatting by default, which can make it difficult to read a 
workbook with a lot of information. Basic formatting can 
customise the look of your workbook, allowing you to draw 
attention to specific sections and making your content easier 
to view and understand. You can use three groups of the Home 
tab for this. They are the Font group, the Alignment group and 
the Number group.

	 (c)	 Write the keyboard shortcut to select the entire worksheet in Excel.
	 Ans.	 Ctrl + A.
	 (d)	 Write about the Bold, Italic and Underline options of the Font group 

of Excel.
	 Ans.	 (i)	 Bold – Used to make text bold in Excel.
		  (ii)	 Italic – Used to make text italic in Excel.
		 (iii)	 Underline – Used to underline text in Excel.
	 (e)	 Mr Albert wants to insert a column between two existing columns in 

an Excel worksheet but he does not know how to do it. Help him 
by telling him the steps to insert the required column.

	 Ans.	 Mr Albert will follow these steps:
		  1.	 He will right click on the column name where the new column is to 

be inserted.
		  2.	 Then, he will select the Insert option from the menu that appears 

to insert the column.
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COMPUTER TIME

	 1.	 Open MS Excel and enter the roll numbers, names, class and 
addresses of 10 of your friends. Use the Font group tools to make it 
look impressive.

	Ans.	 Do it yourself.
	 2.	 Using Ms Excel, create your daily study schedule. 
	Ans.	 Do it yourself.
	 3.	 Open MS Excel and insert the data shown in the figure. Insert a missing 

column named ‘Date of Order’ between ‘Name’ and ‘Item’ and enter 
appropriate data in the new column.

Zone Name Item Units Unit Cost Total
Central Smith Desk 2 125.00 250.00
Central Kivell Desk 5 125.00 625.00
Central Gill Pencil 7 1.29 9.03
Central Jardine Binder 11 4.99 54.89
Central Andrews Pencil 14 1.29 18.06
Central Gill Pen 27 19.99 539.73

	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A.	 1.	 We can edit a cell using one of the following methods:
		  (a) Double-click inside the cell and make changes.
		  (b)	 Select the cell to be edited → make changes in the formula bar 

and press the Enter key.
		  (c)	 Click the cell to be edited → Press the F2 key from the keyboard 

and make required changes
	 2.	 Alignment group.
	 3.	 By clicking inside the cell.
	 4.	 Select the cell and retype to change text or double-click the cell to 

make changes.
	 5.	 Yes. By using the AutoFill tool.
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	 6.	 It is used to combine and centre text in cells into a single large cell.
	 7. 	 (i)  Click on the letter at the top of column to select the entire column.
			  (ii)  Click on the row number to select the entire row.
	 8.	 Decrease Indent – Used to shift the text of a cell closer to the cell 

border in Excel.
		  Increase Indent – Shifts text of a cell away from the cell border in 

Excel.
	 9.	 Select the cell → press the Delete button from the keyboard.
	 10.	 The AutoFill feature of MS Excel allows you to fill in a series of values 

in a worksheet. We use this tool to save time and effort for filling 
multiple entries automatically.

B.	 1.	 Ctrl+X  2. Ctrl+C  3. Ctrl+V  4. Ctrl+O  5. Ctrl+S  6. Ctrl+A
	 7.	 Ctrl+Z

Answers of Worksheet

	 I.  	 1.  (b)  2.  (c)  3.  (a)  4.  (b)  5.  (a)
	 II.  	 1.  number  2.  clicking  3.  Delete  4.  Ctrl+C  5.  Orientation
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Chapter 6
SmartArt Graphics with PowerPoint 2013

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 You can click the Insert a SmartArt Graphic icon present in 

the placeholder to add a SmartArt.
		  (b)	 SmartArt allows you to provide information in a more 

presentable form with the help of graphics.
		  (c)	 For complex SmartArt graphics, working in the task pane is 

often faster.
		  (d)	 Creating a chart with Excel is the best way if your data changes 

regularly.
		  (e)	 PowerPoint also includes several SmartArt styles, which 

allows you to quickly modify the look of your SmartArt.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 You can delete any bullets you’re not using to remove 

the shapes in PowerPoint.	 T
	 	 (b)	 It is difficult to transform traditional bullet points into 

an eye-catching SmartArt graphic with PowerPoint 2013.	 F
		  (c)	 Whenever you select a SmartArt graphic, the Design and 

Format tabs appear on the right side of the Ribbon.	 T

		  (d)	 You cannot make a chart in PowerPoint.	 F
		  (e)	 You can also add text by clicking the desired shape 

and then typing.   	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 You can convert a SmartArt back to text. To do so, go to the 

Design tab present on the right side of the Ribbon.
	 (i)	 View	 (ii)	 Design
	 (iii)	 Animations	 (iv)	 Format



Living with Computers 6 TRM 69

		  (b)	 From the Insert tab, select the SmartArt tab in the Illustrations 
group.

	 (i)	 Tables	 (ii)	 Images
	 (iii)	 Illustrations	 (iv)	 Add-ins
		  (c)	 To change the colour of a SmartArt graphic, select the Design 

tab under SmartArt Tools, click the Change Colors command 
and choose the desired colours from the drop-down menu.

	 (i)	 Drawing Tools	 (ii)	 Chart Tools
	 (iii)	 SmartArt Tools	 (iv)	 None of these
		  (d)	 To change the style of a SmartArt, select the desired style 

from the SmartArt Styles group.
	 (i)	 Layouts	 (ii)	 Create Graphic
	 (iii)	 Reset	 (iv)	 SmartArt Styles
		  (e)	 The text written inside a SmartArt graphic will appear in the 

graphic and will resize itself to fit inside the shape.
	 (i)	 cover	 (ii)	 fit inside
	 (iii)	 overlap	 (iv)	 None of these

4.	Answer the following questions.
	 (a)	 Write a short note on the SmartArt feature of PowerPoint 2013.
	 Ans.	� SmartArt feature helps you to provide information in a more 

presentable form with the help of graphics rather than just using 
text. There are a number of styles available to choose from and 
use them to illustrate many different types of ideas.

	 (b)	 Can you insert a chart in a slide? If yes, write the steps to do this.
	 Ans.	 Yes. To create a simple chart from scratch in a slide, follow these steps:
		  1.	 Select the slide in which you want to insert the chart.
		  2.	 Select the Insert tab and select Chart in the Illustration group.
		  3.	 Select the chart type and then double-click on the chart of your 

choice or click OK.
		  4.	 Replace the placeholder data with your own data and 

information in the worksheet that appears.
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		  5.	 Click the Close button once you have entered the desired data.
	 (c)	 Write the steps to insert SmartArt graphics.
	 Ans.	 To insert a SmartArt graphic, follow these steps:
		  1.	 Select the slide on which you want the SmartArt graphic to 

appear.
		  2.	 From the Insert tab, click the SmartArt tool from the Illustrations 

group.
		  3.	 The Choose a SmartArt Graphic dialog box will appear. Select a 

category  from the left, choose the desired SmartArt graphic 
and then click the OK button.

				   The selected SmartArt graphic will appear on the current slide.
	 (d)	 Ms Diksha wants to change the colours of the SmartArt graphics 

that she has created. Help her do this task.
	 Ans.	 Ms Diksha can follow these steps:
		  1.	 Select the SmartArt on the slide.
		  2.	 Select the Design tab under SmartArt tools and click the Change 

Colors button.
		  3.	 Choose the desired colours from the menu that appears.
	 (e)	 Mr Krish has some text on his slide. He wants to convert the text 

into SmartArt graphics. Help him in converting the existing text to 
a SmartArt.

	 Ans.	� Mr Krish can follow these steps to convert text into a SmartArt 
graphic:

		  1.	 Right-click the list or paragraph he wants to convert into a 
SmartArt.

		  2.	 He will take the mouse pointer over Convert to SmartArt. A list 
of SmartArt options will appear. From here, he can select the 
desired SmartArt graphic.

COMPUTER TIME

	 1.	 Create a PowerPoint presentation on the topic ‘Computer Viruses’. 
Also add SmartArt graphics on any one slide.

	 Ans.	 Do it yourself.
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	 2.	 Create a PowerPoint presentation on  ‘A Balanced Diet’.  Also, create 
a chart on any one slide.

	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
 	 1.	 (d)  2. (e)  3. (a)  4. (b)  5. (c)

Answers of Worksheet

	 I.  	 1.  Column Chart  2.  Line Chart  3.  Pie Chart  4.  Bar Chart
	 II.  	 1.  Pie Chart  2.  Column Chart  3.  Line Chart  4.  Bar Chart
		  5.	 Stacked Chart
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TESTING TIME – 2
(BASED ON LESSONS 4 TO 6)

1.	Write ‘Agree’ or ‘Disagree’ for each of the following statements.
	 Ans.	 (a)	 Mail Merge tool is available in MS Excel.	 Disagree
		  (b)	� In Mail Merge, we can choose the addresses from	  

the list to which we do not want to send a mail.	             Agree
		  (c)	 We cannot select non-adjacent cells in an Excel
			   worksheet.	 Disagree
		  (d)	 Formatting tools are available in the ‘Styles’ tab in
			   MS Excel.	 Disagree
		  (e)	  is the  SmartArt icon of PowerPoint.	 Disagree

2.	Arrange the following steps of Mail Merge in the correct sequence.
	 Ans.	 (a)	 Select the starting document.
		  (b)	� Choose Step-by-Step Mail Merge Wizard from the drop-down 

list.
		  (c)	 Preview the letters.
		  (d)	 Print your letters or edit individual letters.
	 	 (e)	 Select the recipients from the address file.
	 Ans.	 (a)–(b)  (b)–(a)  (c)–(d)  (d)–(e)  (e)–(c)

3.	Write briefly about each of the following Excel tools.
	 Ans.	 (a)	 Decrease Font Size: Used to decrease font size in Excel.
		  (b)	 Align Right: Used to align the text of a cell to the right side in 

Excel.
		  (c)	 Wrap Text: Used to wrap lengthy text of a cell in multiple lines 

in Excel.
		  (d)	 Merge and Center: Used to combine and centre the text of 

cells into a single large cell in Excel.
		  (e)	 Insert Row: This option helps to add a new row or rows 

between existing rows.
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4.	Match the following keyboard shortcuts with the correct 
command.

	 Ans.	 (a)	 Ctrl +A	 (i)	 Italics
		  (b)	 Ctrl + B	 (ii)	 Undo
		  (c)	 Ctrl + I	 (iii)	 Bold
		  (d)	 Ctrl + Y	 (iv)	 Redo
		  (e)	 Ctrl + Z	 (v)	 Select all

5.	Answer the following in one word.
	 Ans.	 (a)	 Viewing the final merged document before	 	
			   printing it.	 Preview
		  (b)	 Keyboard shortcut for underlining.	 Ctrl + U
		  (c)	 Group on the Excel window that contains the
			   Increase Decimal tool.	 Number
		  (d)	 A tool present in the ‘Illustrations’ group of
			   the PowerPoint Ribbon.	 SmartArt
		  (e)	 A chart type.	 Column
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Chapter 7
Introduction to Python

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Syntax is a set of grammatical rules for instructing a computer 

or computing device to perform specific tasks.
		  (b)	 Python is a General-purpose Object Oriented Programming 

language.
		  (c)	 You can press the    F5    key from the keyboard to execute the 

Python file.
		  (d)	 Python was released in the year    1991   .
		  (e)	 REPL stands for Read Eval Print Loop.

2.	Write True (T) or False (F).

	 Ans.	 (a)	 There are four modes to use the Python interpreter.	 F
		  (b)	 The code of a Python file gets executed via the 

Python shell.	 T
		  (c)	 To execute the script by the interpreter, you have to 

tell the interpreter the name of the file.	 T
		  (d)	 The result is immediately displayed on the Python 

shell as soon as the Python interpreter interprets 
the command with the interactive mode.	 T

		  (e)	 If you need to write a long piece of Python code, use 
the script mode.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 The >>> indicates that the Python shell is ready to 

	 execute.
	 (i)	 close	 (ii)	 execute
	 (iii)	 display	 (iv)	 move
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		  (b)	 Python is named after the name of the comedy show.
	 (i)	 python snake	 (ii)	 comedy show
	 (iii)	 comedian	 (iv)	 None of these
		  (c)	 The keyboard shortcut to open a module is Ctrl + O.
	 (i)	 Ctrl + O	 (ii)	 Alt + O
	 (iii)	 Alt + M	 (iv)	 Ctrl + M 
		  (d)	 A Python file gets saved with the    .py    extension.
	 (i)	 .pyt	 (ii)	 .py
	 (iii)	 .pyh	 (iv)	 .pyn
		  (e)	 You must create and save a file before executing your code 

with the Script mode.
	 (i)	 Interactive
	 (ii)	 Script
	 (iii)	 Execution
	 (iv)	 None of these

4.	Answer the following questions.
	 (a)	 Write in brief about any three features of the Python language.
	 Ans.	 	 Python can be used on a server to create web applications.
		  	 �Python can connect to database systems. It can also read and 

modify files.
		  	� Python can be used to handle Big Data and perform complex 

mathematical calculations.
		  	� It is used for developing applications and projects based on 

Artificial Intelligence. [Any 3]
	 (b)	 Differentiate between the Interactive mode and the Script mode of 

the Python Interpreter.
	 Ans.	  (i)	 Interactive Mode:  Interactive mode, also known as Read Eval 

Print Loop (REPL), provides us with a quick way of running a 
block or a single line of Python code. Without passing the 
Python script file to the interpreter, it gets executed directly.
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		  (ii)	 Script Mode: In this mode, the source code is stored in a file 
with the .py extension and the interpreter is used to execute 
the contents of the file. If you need to write a long piece of 
Python code, use the script mode. Note that you can use any 
text editor for this, including Sublime, Atom, Notepad++, etc. 
To execute the script by the interpreter, you have to give it the 
name of the file.

	 (c)	 Mention any two advantages and two disadvantages of using the 
Interactive mode of Python.

	 Ans.	   (i)	Advantages of using the Interactive Mode
			   1.	 Helpful when your script is short and you want immediate 

results.
			   2.	 Faster as you only have to type a command and then press 

the Enter key to get the results.
		   (ii)	� Disadvantages of using the Interactive Mode
			   1.	 Editing the code in interactive mode is hard as you have to 

move back to the previous commands or else you have 
to write the whole command again.

			   2.	 It’s very tedious to run long pieces of code.
	 (d)	 Write the steps to execute a piece of code in the Script mode.
	 Ans.	� 1.	� In the interactive mode, select the File tab and then select New 

File.
		  2.	 Write the command in the Python shell.
		  3.	 Now select the File tab and then select Save As to save the 

file.
		  4.	 The Save as dialog box will appear. Give the file name and 

click the Save button.
		  5.	 Click the Run button and select Run Module to execute the 

Python file.
		  6.	 A separate Python shell will open with the output.
	 (e)	 Write the benefits of using Python language over other 

programming languages.
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	 Ans.	� 1.	 It is very easy to learn.
		  2.	 It can be used for developing AI projects.
		  3.	 It is an open-source language.

COMPUTER TIME

	 1.	 Execute the following code in both Interactive mode and Script mode.
		  (a)  4 + 6 -2
		  (b)  10 + 8 – 7 
		  (c)  7 * 3 + 2
		  (d)  14 / 2 + 4
	 Ans.	 Do it yourself.
	 2.	 Write a program in Python shell to print your roll no., name and class.  
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
A.	 1.	 programming  2. Python  3. Interactive  4. .py
	 5.	 Run module
B.	 1.	 (d)  2. (e)  3. (a)  4. (b)  5. (c)

Answers of Worksheet

		  1.  Yes, Python is highly case-sensitive.
		  2.	 Python is a General-purpose Object Oriented Programming 

language, so even if you are new to programming, you can learn 
Python without facing any issues.  It is derived from programming 
languages such as ABC, Modula 3, Smalltalk and Algol-68. This 
language is also used for developing Artificial Intelligence (AI) 
applications and projects.

		  3.	 Python is an open-source language because it can be downloaded 
free of cost with source.

		  4.	 Interactive Mode and Script Mode.
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	 	 5.	 Interactive Mode provides a quick way of running blocks or a 
single line of Python code.Without passing the Python script file 
to the interpreter, it gets executed directly.

	 	 6.	 In Interactive mode, the codes are not passed to an interpreter 
as they get executed directly. In Script mode, the source code is 
stored in a file with the .py extension and the interpreter is used 
to execute the contents of the file.

		  7.	 Step 1:	 In interactive mode, click on the File tab and select New 
File.

			   Step 2:	 Write the command in Python shell.
			   Step 3:	 Now click on File tab and select Save As to save the file.
			   Step 4:	 On clicking Save As, the Save As dialog box will appear. 

Now give the file name and click the Save button.
			   Step 5:	 Click on the Run button and select Run Module to execute 

the Python file.
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Chapter 8
Animation with Flash CS3

DO AND LEARN!

1.	Fill in the blanks.
	 Ans.	 (a)	 Timeline is a record of every frame, layer and scene in your 

movie.
		  (b)	 Stage is also called the virtual canvas.
		  (c)	 Panels help you to view, organise, and change elements in 

your Flash document.
		  (d)	 Flash creates a tabbed panel-group known as the Property 

Inspector.
		  (e)	 In Flash, the panel-group has two tabs: Properties tab 

and Parameters tab.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Stage is the actual area in which your movie	
			   is displayed	 T 	

		  (b)	 FPS stands for Flash Per Second.	 F
	 	 (c)	 Several buttons have flyouts, which are like submenus 

for the toolbars.	 T
		  (d)	 Icons that appear in the Options section at any given 

time, do not depend on which tool you’ve selected.	 F
		  (e)	 When you are creating something in Flash, you are 

drawing one of the two things: a stroke or a fill.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 It displays text and menus for choosing symbols and scenes 

to work upon.
	 (i)	 Timeline	 (ii)	 Edit bar
	 (iii)	 Stage	 (iv)	 Property Inspector
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		  (b)	 Each Flash document consists of    3    basic items.
	 (i)	 4	 (ii)	 5
	 (iii)	 2	 (iv)	 3
		  (c)	 Flash’s default setting is    12    frames per second.
	 (i)	 10	 (ii)	 8
	 (iii)	 7 	 (iv)	 12
		  (d)	 In Flash Professional, the panel has a third tab named the     

Filters tab.
	 (i)	 Filters	 (ii)	 Properties
	 (iii)	 Parameters	 (iv)	 Timeline
		  (e)	 On clicking the Background colour control, the pointer changes 

to Eyedropper.
	 (i)	 Hand	 (ii)	 Eyedropper
	 (iii)	 Arrow	 (iv)	 None of these

4.	Answer the following questions.
	 (a)	 What all things can you create using Adobe Flash CS3?
	 Ans.	� A few of the things that can be created with Flash are:
		  	 Drawings and animations
		  	 Multimedia websites
		  	 Banner ads
		  	 Tutorials 
		  	 Full-length ads and product presentations
		  	 Customer service kiosks
		  	 Television and film effects
		  	 Games and other programs
	 (b)	 Differentiate between Colour Tools and View Tools.
	 Ans.	  (i)	 Colour Tools:  When you are creating something in Flash, you 

are drawing one of two things: a stroke, which is a plain line 
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or outline, or a fill, which is the area within an outline. Before 
you click one of the drawing icons to begin drawing, you can 
use these tools to choose a colour from the colour palette, and 
Flash applies that colour to the Stage as you draw.

		  (ii)	� View Tools:  At times, you may draw a picture that is so big that 
you can’t see it all on the Stage at one time or perhaps draw 
something that you want to modify pixel by pixel. When either 
of these situations occurs, you can use the tools that Flash 
displays in the View section of the Tools panel. These tools 
are used to zoom in, zoom out and pan around the Stage.

	 (c)	What is the role of Timeline in a flash document?
	 Ans.	� The Timeline determines the order in which the frames appear in 

and for how long each frame stays on the Stage. If you’ve decided 
to organise the images on your frames into separate layers, the 
Timeline is where you specify how you want your layers stacked: 
which layer you want on top, which beneath that, and so on.

	 (d)	Write briefly about the following:
		   (i)	 Options Tools
		  (ii)	 View Tools
	 Ans.	  (i)	 �Options Tools:  Icons that appear in the Options section at 

any given time, depend on which tool you’ve selected. For 
example, if you select the Zoom tool from the View section of 
the Tools panel, the Options section displays an Enlarge icon 
and a Reduce icon that you can use to change the way the 
Zoom tool works.

		  (ii)	 View Tools:  At times, you may draw a picture that is so big 
that you can’t see it all on the Stage at one time or perhaps 
draw something that you want to modify pixel by pixel. When 
either of these situations occurs, you can use the tools that 
Flash displays in the View section of the Tools panel. These 
tools are used to zoom in, zoom out and pan around the Stage.
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	 (e)	 Write the steps to change the background colour.
	 Ans.	� To change the background colour, follow these steps:
		  1.	 Open the Document Properties dialog box. To assign your 

Stage a new colour, choose one from the Background colour 
control in the Document Properties dialog box.

		  2.	 Click the Background colour control.
				   The pointer changes to an eyedropper, and a set of swatches 

appears.
		  3.	 Click OK.

COMPUTER TIME

	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A.	 T O O L S G J N O J

I K K V Y T R P O W
M S U M U I A L Y E
E M T K R N N G S B
L D A U E K T J E C
I T B L N N E R I A
N W S O H F R D C M
E K O U S E F O K N

B.	 1.	 (b)  2. (a)  3. (c)  4. (a)  5. (c)

Answers of Worksheet

	 I.  	 1.  Document Properties  2.  View Tools  3.  Timeline  4.  Panels
		  5.  Modify → Document
	 II.  	 1.  (c)  2.  (d)  3.  (a)  4.  (e)  5.  (b)
	 III.	 1.  Flash is an animation software by Adobe.
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		  2.	 It is a record of every frame, layer and scene in your movie.
		  3.	� The Stage, located at the center of your Flash workspace, is your 

virtual canvas. This is the area where you will draw the pictures 
and eventually string them together to create your own animation.

		  4.	   Selection and Drawing tools
				     View tools
				     Color tools
				     Options tools
		  5.	 	� Timeline: A record of every frame, layer and scene in your 

movie.
				   	 Edit bar: It displays text and menus for choosing symbols and  

		  scenes to work upon.
				   	 Stage: It is the actual area in which your movie displays.
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Chapter 9
More About Flash

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Tools panel is the most used panel in Flash.
		  (b)	 Selection tool helps to select and modify an object’s shape.
		  (c)	 The two tools in the View section of the Toolbox are Hand tool 

and Zoom  tool.
		  (d)	 With the help of the Zoom tool, we can see the object or 

picture with a larger view and modify it at the right place as 
required.

		  (e)	 To break picture, press the Ctrl + B keys.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 When we need to change in order to make different 

shapes of a drawn graphic in the document, we use 
the Selection tool.	 T

		  (b)	 FPS stands for Frames Per Second.   	 T

		  (c)	 A blank key frame is also called a layer.	 F
		  (d)	 ‘F8’ is the keyboard shortcut to convert an object into a 

symbol.	 T
		  (e)	 Animations can be created with the frame-by-frame 

technique only.	 F

3.	Tick () the correct option.
	 Ans.	 (a)	 The keyboard shortcut to show/hide the Property Inspector is:
	 (i)	 CTRL+F2	 (ii)	 CTRL+F5
	 (iii)	 CTRL+F3	 (iv)	 CTRL+F4
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		  (b)	 Library is a storage facility for all media elements used in a 
Flash file.

	 (i)	 Library	 (ii)	 Instance
	 (iii)	 Symbol	 (iv)	 Tween
		  (c)	 The Ink Bottle tool is used to change the stroke colour.
	 (i)	 Paint Bucket	 (ii)	 Ink Bottle 
	 (iii)	 Fill color	 (iv)	 None of these
		  (d)	 Pressing the Shift key while drawing a line will draw straight, 

horizontal, vertical or diagonal lines.
	 (i)	 Ctrl	 (ii)	 Alt
	 (iii)	 Enter	 (iv)	 Shift
		  (e)	 Which of the following is not a technique of animation in Flash?
	 (i)	 Frame-by-frame	 (ii)	 Size Tweening
	 (iii)	 Shape Tweening 	 (iv)	 Motion Tweening

4.	Answer the following questions.
	 (a)	 What do you understand by the term ‘Frame Rate’ with respect to 

animation in Flash?
	 Ans.	 �The rate, stated in frames per second (fps), at which each frame in 

an animation is played back for the user, is called the frame rate.
	 (b)	 Differentiate between key frame and blank key frame.
	 Ans.	  (i)	 Key frame:  A frame in which you establish exactly what 

should appear on the stage at that particular time.
		  (ii)	 Blank key frame:  It is simply a frame with no content. In a new 

Flash document, you have one blank key frame by default.
	 (c)	 What is the use of the Eye dropper tool in a Flash document? Give 

one example.
	 Ans.	 �Eye Dropper Tool:  This tool helps to pick any colour from a picture 

or graphic and use it in case the colour is not available in the Colors 
palette. Open any coloured picture and pick the colour using the 
Eye Dropper tool. Now, use the colour anywhere in your document 
as required.
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	 (d)	 Name different types of animation techniques available in Flash. 
Write briefly about each technique.

	 Ans.	 Different animation techniques available in are:
		  (i)	 Frame-by-Frame Animation:  Frame-by-frame animation is 

how cartoons have been animated since the early days of 
animation. Using this method, the animator draws a figure or 
scene one frame at a time, drawing slight differences between 
each frame. When the frames are viewed in rapid sequence, 
the differences between them create the illusion of change or 
motion. In Flash, animators impose frame-by-frame animations 
over still images or other types of animation to avoid redrawing 
an entire scene for every animation frame.

		  (ii)	 Tweened Animation:  In tweened animation, all a user has to 
do is to define the contents of the first and the last frame of 
a particular animation.  After this, Flash will generate all the 
frames between the two defined frames on its own.  For all the 
animations where you have to change the shape or position of 
an object over time during an animation, you can use tweened 
animations. 

				   Tweened animations work very fast and are of small size. 
There are two types of tweened animations that can be created 
in Flash:

				   1.  Motion tweening
				   2.  Shape tweening
	 (e)	 Ananya wants to create an animation showing a boy moving 

ahead step-by-step. Help her do this by writing the steps she 
should use to accomplish this task.

	 Ans.	 Ananya can follow these steps by using frame-by-frame 
animation:

		  1.	 In frame 1, draw the boy. 
		  2.	 Insert a keyframe in the next frame and change the position of 

the boy slightly ahead.
		  3.	 Keep repeating step 2 until the boy reaches a certain distance 

on the stage.
		  4.	 Save and play the animation.
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COMPUTER TIME

	 1.	 Start Flash CS3 on your computer. Take a screenshot of the starting 
window and paste it on a Word document. Now, using drawing tools, 
label the following:

		  (a)	 Property Inspector	 (b)	 Timeline
		  (c)	 Frames	 (d)	 Stage
		  (e)	 Tool Panel
	 Ans.	 Do it yourself.
	 2.	 Create a new Flash CS3 document and do the following:
		  (a)	� Draw any picture using all the drawing tools taught in this 

lesson.
			  (b)	 Fill appropriate colours as desired.
			  (c)	 Type a caption using the Text tool.
			  (d)	� Convert it into a symbol and use the frame-by-frame animation 

technique to move the picture.
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities

R S L S D L A Y E R

T R A N S F O R M W

L Y S T A X Z S Y T

I C S L Z Q W B N W

B O O U S K T J T E

R S Q P G V T R I E

A W S Y M B O L C N

R M G I Q V X V K X

Y X G R A D I E N T
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Answers of Worksheet
	 I.  	 1.	 It is a free-hand tool used to select an object and delete the 

unwanted parts from it.
		  2.	 It is used to remove or rub any mistakes you make in your 

drawings.
		  3.	 It is used to draw a star or polygon.
		  4.	 It helps to select and modify objects and shapes.
		  5.	 It is used to change the stroke colour.
	 II.  	 1.  Ink Bottle tool  2.  Text tool  3.  Pencil tool  4.  Polygon tool
		  5.  Eraser tool.
	 III.  	 1.  (a)  2.  (c)  3.  (a)  4.  (b)  5.  (a)
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Chapter 10
Computer Virus

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Antivirus is a program that protects a computer from virus.
		  (b)	 A Trojan Horse cannot replicate itself.
		  (c)	 Worm is a malicious software.
		  (d)	 A virus has the ability to replicate itself.
		  (e)	 An illegal copy of software is pirated software.

2.	Write True (T) or False (F).

	 Ans.	 (a)	 A Trojan is an antivirus program.	 F
		  (b)	 A virus harms only the hardware and not the data of a 

computer.	 F
		  (c)	 Always scan your e-mail attachments before opening 

them. 	 T
		  (d)	 Polymorphic viruses try to escape the antivirus programs. 	  

	 T

		  (e)	 A virus does not affect the speed of a computer.	 F

3.	Tick () the correct option.
	 Ans.	 (a)	 Boot sector viruses take control when you start your 

computer.
	 (i)	 Polymorphic viruses	 (ii)	 Macro viruses
	 (iii)	 File infector viruses	 (iv)	 Boot sector viruses
		  (b)	 A virus infects a computer system if the latest, updated version 

of Antivirus is not installed on the computer.
	 (i)	 Trojan	 (ii) 	Antivirus
	 (iii)	 Pirated software	 (iv)	 Flash Drive
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		  (c)	 To stay safe, Never download unexpected text or email 
attachments from websites you don’t trust.

	 (i)	 Always	 (ii)	 Sometimes
	 (iii)	 Never	 (iv)	 None of these
		  (d)	  A computer virus is a Software program.
	 (i)	 Piece of hardware	 (ii)	 Software program
	 (iii)	 Useful program	 (iv)	 Both (i) and (ii)
		  (e)	  A Resident virus can execute any time an operating system 

loads.
	 (i)	 Web scripting virus	 (ii)	 Worm
	 (iii)	 Resident virus	 (iv)	 Trojan horse

4.	Answer the following questions.
	 (a)	 Name the different types of computer virus.
	 Ans.	 �Boot sector virus, web scripting virus, resident virus, polymorphic 

virus, micro virus.
	 (b)	 Name any five sources through which a computer can be infected 

by a virus.
	 Ans.	� Sources of Virus:
		  (i)	 Infected secondary storage device
		  (ii)	 While downloading content from the Internet
		 (iii)	 Through e-mail attachments
		 (iv)	 Spam mails
		  (v)	 Unexpected pop-up windows
	 (c)	 What are the best ways to avoid computer viruses?
	 Ans.	 �The following are some precautions which can protect a computer 

system from viruses:
		  	 Avoid clicking on any pop-up advertisements.
		  	 Always scan your e-mail attachments before opening them.
		  	 Always scan the files that you download using file sharing 

programs.
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		  	 Use a trusted, latest version of antivirus, such as Norton Antivirus, 
and keep it updated with the latest virus definitions. 

		  	 Always visit trustworthy websites only.
		  	 The latest version of firewall should be installed on the 

computer.
		  	 USB drives should be scanned for viruses, and should not be 

used on infected computers.
		  	 Spam or unknown e-mails should not be opened and must be 

deleted without opening.
		  	 Unauthorised or pirated software should not be installed on the 

computer.
		  	 Always keep a backup of your data on a regular basis. The 

backup can be used if the virus deletes or modifies your 
data. There are some great software that can back up your 
data automatically.

		  	 Never download songs, videos or files from suspicious websites.
		  	 Never share your personal data with people you don’t know over 

the Internet.
	 (d)	 Define worm. How does it infects a computer system?
	 Ans.	 �A computer worm is a type of malicious software program whose 

primary function is to infect other computers while remaining active 
on infected systems. It has the following features:

		  (i)		 It is self-replicating malware, which means that it can create 
multiple copies of itself and spread to uninfected computers. 

		  (ii)	 Worms often use those parts of an operating system that are 
automatic and invisible to the user. 

		 (iii)	 A computer worm infection spreads without the user’s 
interaction.

		 (iv)	 Computer worms may spread through infected storage media 
such as floppy disks, pen drives, infected hard disks, etc., 
which, when used on a system, infect other storage devices 
connected to the system. 
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	 (e)	 Differentiate between polymorphic viruses and macro viruses.
	 Ans.	  (i)	 Polymorphic Virus: A polymorphic virus changes its code 

each time an infected file is executed. It does this to escape 
antivirus programs.

		  (ii)	 	Macro Virus: Macro viruses are written in the same macro 
language used for software applications. Such viruses spread 
when you open an infected document, often through e-mail 
attachments.

	 (f)	 Jayati is working on a very important project on her computer. She is 
taking information about the topic from the Internet also. Suddenly 
her computer becomes very slow. She restarts the computer and 
is shocked to find that her project file has been deleted.

		   (i)	 What could have gone wrong?
		  (ii)	 Mention any two precautions that Jayati should have followed 

while using the internet.
	 Ans.	  (i)	 Jayati’s computer could be infected by virus.
		  (ii)	  � Jayati should have installed a good quality antivirus on her 

computer.

				     She should not open e-mails from unknown senders.

COMPUTER TIME

Prepare a PowerPoint presentation on the topic ‘Computer Virus’. Collect 
some new information on the topic from the Internet and incorporate it in 
the presentation.
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
A.	 1.	 (c)  2. (e)  3. (a)  4. (d)  5. (b)
A.	 1.	 WORM  2. ANTIVIRUS  3. SPYWARE  4. SPAM  5. TROJAN
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Answers of Worksheet
	 I.  	 1.  Malware  2.  Trojan Horse  3.  Spam  4.  Boot Sector
		  5.  pirated software.
	 II.  	 1.  T  2.  F  3.  F  4.  F  5.  T
	 III.  	 1.  (c)  2.  (a)  3.  (d)  4.  (b)  5.  (b)
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Chapter 11
Internet Services

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Internet services can be categorised into four different 

categories.
		  (b)	 A learning system based on formalised teaching with the help 

of electronic resources is known as e-learning.
		  (c)	 Messages written on Twitter are known as tweets.
		  (d)	 Facebook is a social networking website where users can 

post comments, share photographs and post links or other 
interesting content on the Web.

		  (e)	 E-shopping is a form of electronic commerce which allows 
consumers to directly buy goods or services from a seller over 
the Internet.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Private tweets can be read by anyone who is using		  

Twitter.	 F

		  (b)	 Facebook was founded by Mark Zuckerberg. 	 T
	 	 (c)	 Photos, documents and other files cannot be attached 

to an e-mail.	 F
		  (d)	 Data security cannot be controlled while sharing 

information using cloud computing.	 F

		  (e)	 WWW stands for World Wide Web.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 Instant Messaging is a Communication service.
	 (i)	 Social Networking	 (ii)	 Communication
	 (iii)	 Online	 (iv)	 Information Retrieval
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		  (b)	 E-Banking is an electronic payment system that enables the 
customers of a bank to conduct a range of financial transactions 
through the financial institution’s website.

	 (i)	 E-Banking	 (ii)	 E-Shopping
	 (iii)	 E-Learning	 (iv)	 E-Ticketing
		  (c)	 Facebook  is a real-time social networking site.
	 (i)	 Twitter	 (ii)	 Google
	 (iii)	 Facebook 	 (iv)	 None of these
		  (d)	 Facebook is one of the best ways to stay connected with 

famous personalities.
	 (i)	 Facebook	 (ii)	 Internet
	 (iii)	 Twitter	 (iv)	 Chatting
		  (e)	 Conferencing means talking to other people over the Internet.
	 (i)	 Gossiping	 (ii)	 Communicating
	 (iii)	 Conferencing	 (iv)	 Chatting

4.	Answer the following questions.
	 (a)	 Name the four different categories of Internet services.
	 Ans.	 �The Internet provides many kinds of services to the user.  These 

services can be categorised into four different types. They are:
		    Communication Services
	 	   Information Retrieval Services
		    Social Networking 
	 	   Online Services
	 (b)	 Write in brief about each of the following:
		  (i)	 Information Retrieval Services
		  (ii)	 Video Conferencing
		 (iii)	 E-Banking
	 Ans.	 (i)	 Information retrieval services offer easy access to information 

present on the Internet. Some of them are:
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			     E-Learning                           Research                       News
		  (ii)	 Video conferencing is a technology that allows users in different 

locations to have face-to-face meetings without having to 
move to a single location together. This technology also saves 
the time, expense, and hassle associated with business travel. 
Uses for video conferencing include holding routine meetings, 
negotiating business deals and interviewing job candidates.

		 (iii) 	E-banking, also known as Internet banking or virtual banking, 
is an electronic payment system that enables the customers 
of a bank or other financial institutions to conduct a range of 
financial transactions through the financial institution’s website. 
Using this, a client executes banking transactions via electronic 
means.

	 (c)	 Write a short note on cloud computing.
	 Ans.	 �Cloud computing is the delivery of computing services including 

servers, storage, databases, networking, software, analytics, 
and intelligence over the Internet, i.e., ‘the cloud’, to offer faster 
innovation and flexible resources. You pay only for the cloud 
services that you use, helping lower your operating costs.

		 Advantages of Cloud Computing:
		  	 Easy implementation
		  	 Readily manageable 
		  	 Accessibility
		  	 Easy collaboration and sharing among users in multiple locations
		  	 No hardware requirement
		 Disadvantages of Cloud Computing:
		  	 Data security cannot be controlled while sharing information.
		  	 No back up
		  	 Bandwidth issues
	 (d)	 Discuss the features of e-mail.
	 Ans.	 �Features of E-mail:
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		  	 Free and Global Delivery: Sending an e-mail is virtually free, 
except for the cost of the Internet service. E-mail can be sent 
to anyone anywhere around the world.

		  	 Speed: An e-mail can be sent and received by many people at 
one go over the Internet.

		  	 File attachment: An e-mail can include one or more file 
attachments, allowing a person to send documents, pictures or 
other files with an e-mail.

		  	 Eco friendly: Sending an e-mail is environment friendly as it 
does not require paper, thus conserving paper resources.

	 (e)	What do you understand by the term ‘social networking’? Explain 
briefly.

	 Ans.	 �Social Networking:  Social networking allows exchange of 
information between applications on the Web, such as Facebook 
and Twitter.

		  Facebook is a social networking service and website started in 
February 2004. It was founded by Mark Zuckerberg. Facebook 
is a social networking website where users can post comments, 
share photographs and post links or other interesting content on 
the Web,

		  Twitter is an American online news and social networking service 
on which users post and interact with messages known as 
‘tweets’. Users use mobile phones or computers to send and read 
messages, called ‘tweets’.

COMPUTER TIME

Visit a bank with your parents and find out how it is using computers with 
networking and the Internet for its various operations. Note down the points 
and make a PowerPoint presentation on it. You may add some more points 
after searching from the Internet.
	 Ans.	 Do it yourself.



Living with Computers 6 TRM132

Answers of Suggested Class Activities
 	 1,	 2 and 3: Students can do these activities on their own.

Answers of Worksheet

	 I.  	 1.  (c)  2.  (d)  3.  (e)  4.  (a)  5.  (b)
	 II.  	 1.  E-MAIL  2.  FACEBOOK  3.  TWITTER  4.  CLOUD
		  5.  NETWORKING
	 III.  	 1.  (b)  2.  (c)  3.  (a)  4.  (d)  5.  (c)
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TESTING TIME – 3
(BASED ON LESSONS 7 TO 11)

1.	Match the following:
	 Ans.	 (a)	 Open source	 (i)	 Flash
		  (b)	 File extension	 (ii)	 Trojan Horse
		  (c)	 Adobe	 (iii)	 Animation
		  (d)	 Frame-by-frame	 (iv)	 .py
		  (e)	 Malicious	 (v)	 Python

2.	Name the Internet service being mentioned in each of the following.
	 Ans.	 (a)	 Sending a letter to somebody	 E-mail			
		  (b)	 Communicating live via text messages	 Instant messaging
		  (c)	 Face-to-face meetings without having to 

move to a single location.	 Video conferencing
		  (d)	 Learning through the Internet.	 E-learning
		  (e)	 Buying goods online	 E-shopping
3.	 Identify and name the computer virus.
	 Ans.	 (a)	 I attack when you boot your computer.	 Boot sector virus
		  (b)	 I can take sensitive information and harm 		  

your network.	 Spyware
		  (c)	 I can change my code each time an	  

infected file is executed.	 Polymorphic Virus
		  (d)	 I am the junk mail in your e-mail account.	 Spam
		  (e)	 My primary job is to infect other computers while remaining 

active on infected systems.	 Worm
4.	Write short note on each of the following.
	 (a)	 Interactive mode of Python language
	 Ans.	 	 Interactive mode, also known as Eval Print Loop (REPL) 

provides a quick way of running blocks on a single line of Python 
code. Without passing the Python script to the interpreter, it 
gets executed directly.

	 (b)	 Timeline in Flash CS3
	 Ans.	� The Timeline determines the order in which the frames appear 

in and for how long each frame stays onstage. If you’ve decided 
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to organise the images on your frames into separate layers, the 
Timeline is where you specify how you want your layers stacked: 
which layer you want on the top, which beneath that, and so on.

	 (c)	 Trojan horse virus
	 Ans.	� Trojan horse is a program that appears harmless but is actually 

malicous. Unexpected changes to the computer settings and 
unusual activities even when the computer is idle are strong 
indications that a Trojan is residing on the computer. Unlike a 
computer virus, a Trojan horse is neither able to replicate itlself, 
nor can it propagate without the user’s assistance.

	 (d)	 Motion tweening in Flash
	 Ans.	 �This type of animation requires users to define the starting position 

of a key frame as well as the ending position. Flash will then fill 
all the frames that lie between the defined frames and create an 
animation. An object has to be converted into a symbol so that the 
motion tween can be applied.

5.	Answer the following questions briefly.
	 (a)	 Mention any two uses of the Python language.
 	 Ans.	 1.	 Python can be used on a server to create web applications.
		  2.	 Python can connect to database systems. It can also read and 

modify files.
	 (b)	What is the purpose of Flash software?
	 Ans.	 It is used to create animations.
	 (c)	 Name any three techniques of Flash animations.
	 Ans.	 Frame-by-Frame, Motion tween and Shape tween.
	 (d)	What do you understand by the term ‘Pirated software’?
	 Ans.	 An illegal copy of software is called pirated software.
	 (e)	 Write a short note on E-learning.
	 Ans.	 A learning system based on formalised teaching with the help of 

electronic resources is known as  e-learning. While teaching can 
be based in or out of the classrooms, the use of computers and the 
Internet forms a major component of e-learning.

PROJECT WORK
	 Ans.	 Do it yourself.
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